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The extension card must be installed and operated only by professionals who have taken part
in professional training on electrical operation and safety knowledge, obtained the certification,
and been familiar with all steps and requirements for the installing, commissioning, operating,
and maintaining, and are capable of preventing all kinds of emergencies.

Safety precautions

Before installing, removing, or operating the extension card, read the safety precautions
described in this manual and the variable-frequency drive (VFD) operation manual carefully to
ensure safe operation.

We are not responsible or liable for any physical injuries or device damage caused due to your
neglect of the safety precautions described in this manual and the VFD operation manual.

o You need to open the VFD housing to install or remove the extension card. Therefore,
you must disconnect all power supplies of the VFD and ensure that the voltage inside
the VFD is safe. For details, see the description in the VFD operation manual. Severe
physical injuries or even death may be caused if you do not follow the instructions.

L] Store the extension card in a place that is dustproof and damp-proof without electric
shocks or mechanical pressure.

) The extension card is electrostatic sensitive. Take measurements to prevent
electrostatic discharge when performing operations involving it.

[ Tighten the screws up when installing the extension card. Ensure that it is firmly fixed
and properly grounded.
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1 Product confirmation

Check the following after receiving Goodrive350 series VFD Auto Station programmable
extension card:

° Whether the extension card is damaged.

° Whether the received extension card is the one you purchase according to the bar
code label on the PCB.

° Whether all the following items are contained in the product package:
One extension card, one tie buckle, one tie, one M3 screw, and one manual

If the extension card is damaged, a wrong model is delivered, or some items are missing,
contact the supplier in a timely manner.

Confirm the environmental requirements for application.

Table 1.1 Environmental requirements

Item Requirement
Working temperature -10-50°C
Storage temperature -20-60°C
Relative humidity 5%—95%
Other weather No condensation, ice, rain, snow, or hail;
conditions Solar radiation < 700 W/m?

Air pressure 70-106kPa

Vibration and impact 5.9m/s? (0.6g) at the sine vibration of 9 Hz to 200 Hz
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2 Product overview

2.1 Extension card introduction

GD350 series VFD Auto Station programmable extension card (hereinafter called PLC card)
works with the VFD to replace small-size PLC in certain application cases. INVT Auto-Control
Technology (Shenzhen) Co., Ltd. (INVT Auto-Control for short) develops the Auto Station to
perform secondary program development on the PLC card, supporting three programmable
languages, including the instruction language (IL), ladder diagram (LD), and sequential
function chart (SFC). The PLC card has 16K step user program storage space and 8K words
data storage space (D elements) for easy development. After completing programs on the
Auto Station, you can upload the programs through the mini-USB interface to the PLC card for
running. The PLC card transfers data to the VFD so as to control VFD running and modify
parameters. In addition, the PLC card provides the power-outage saving function, which will
save the values about 1K words of the M/S/D/C elements in case of power outage if you have
specified the saving range on the Auto Station. You can use the RS485 channel for network
communication. The standard Modbus protocol has been embedded into the PLC card so that
the master/slave switchover can be performed on the Auto Station. The PLC card also
provides the DP/CANopen/PN card with the PZD channel, through which data can be
transferred from the DP/CANopen/PN card to the PLC card for secondary programming or
from GD350 to the PLC card and then transferred to the DP/CANopen/PN card.

When the PLC card works with the VFD, all the external I/O terminals of the VFD can be
invoked by the PLC card, enriching the 1/O points of the PLC card.

2.2 Models

The following is a GD350 extension card model example:
EC-PC502-00
O @ @ 6

Figure 2.1 Extension card model example

Table 2.1 Extension card model description

No. Field Description
[©) Product category EC: Extension card
10: 1/0 extension card
Extension card TX: Communication extension card
2 type PG: PG card
PC: PLC programmable card
® Technical version An odd such as 1, 3, or 5 is used to indicate the
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No. Field Description
iteration 1, 3, or 5 of the technical version.
01: 10 points
e 02: 8 points of I/0, 1 point of Al, 1 point of AO, and 1
Identi d . -
® entifying code point of RS485 communication
03: Reserved
Special .
® p Reserved. The default value is 00.
requirement

2.3 Terminal layout

The terminal layout of the PLC card is as follows:

‘ PE | 485- | 485+ I GND ‘ AlL | AO1 ‘

The following table describes the functions of the terminals.

coM | com | ps1 | ps2 | ps3 ‘ PRO2A ’ PRO2C ‘
PW 24V | PS4 | Ps5 | Pse PROIA | PROIC

Figure 2.2 Terminal layout of the PLC card

Table 2.2 Terminals of the PLC card

Category Symbol Name Function
To provide input digital
working power  from
PW External power | external to internal.
Power supply supply Voltage range: 12-24V
PW and +24V are short
connected by default.
2av Internal power | Internal output power
supply supply, 100mA
Common  terminal  of
coMm Common terminal | +24V.If PS1is connected,
of +24V COM indicates PS1 is
Common connected.
terminal/ground Reference zero potential
GND Analog ground of +10V
PE Protective Protective earthing
earthing terminal terminal
Digital input PS1 Digital input 1 1. Internal
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Category

Symbol

Name

Function

PS2

Digital input 2

PS3

Digital input 3

PS4

Digital input 4

PS5

Digital input 5

PS6

Digital input 6

impedance: 4kQ
2. Accept
voltage input

3.  Bi-directional
terminal

4. Max.
frequency: 1kHz
5. Both source and sink
inputs are allowed, but the
input types must be the
same

12-30vV

input

input

Analog
and output

input

All

Analog input 1

1. Input range: All
voltage and current range:
0-10V, 0-20mA

2. Input  impedance:
20kQ during voltage input;
250Q during current input
3. Voltage or current input
is set through the jumper.
4. Resolution  ratio:
When 10V corresponds to
50Hz, the min. resolution
ratio is 5mV

5. Deviation: +1%
when the input reaches
full  the measurement
range at 25°C

AO1

Analog output 1

1. Output range:
0-10V voltage or 0-20mA
current

2. Voltage or current
output is set through the
jumper.

3. Deviation: #1% when
the input reaches full the
measurement range at
25°C.

Relay output

PRO1A

NO contact of
relay 1

1. Contact  capacity:
2A/AC250V, 1A/DC30V
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Category Symbol Name Function
PROLC Common contact 2_. Unable to functlon. as
of relay 1 high frequency switch
output
PRO2A NO contact of (o]
relay 2
PRO2C Common contact
of relay 2
RS485 communication
485+ port, which can be set as
the master or slave
RS485 through the Auto Station.
Communication communication It is differential signal
terminal output. Whether to
485-

connect the 120Q resistor
of RS485 is set through
the jumper.

Note:

® The jumpers used for connection are at the side of the PE, 485-, 485+, GND, All, and
AOL1 terminal block.

® Al and AV are the current and voltage selection options of analog input All and the
connection to jumper J2 determines the input type.

® AlO and AVO are the current and voltage selection options of analog output AO1 and the
connection to jumper J5 determines the output type.

® The symbol "120" indicates the 120Q resistor, which can be connected to jumper J1. By
default, J1 connects to NC, J2 connects to AV, and J5 connects to AVO.

™ 0k it N

O ST O AY 2T

Figure 2.3 PLC card
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2.4 Status indicators

The dial switch SW1 on the PLC card can control the running and stop of programs on the
card. The PLC card provides five status indicators to represent the status.

Table 2.3 Status indicators

Indicator
No.

Represents

Function

LED1

PWR  power
indicator (green)

supply

It is steady on when the PLC card
is powered on.

LED3

COMM  communication
indicator (green)

It is steady on when the PLC card
is establishing connection to the
control board.

When the PLC card properly
connects to the control board, it
turns on for 0.5 second and turns
off for 0.5 second in a regular
way.

When the PLC card is
disconnected from the control
board, it is steady off.

LED4

ERR fault indicator (red)

When a fault occurs, it turns on
for 0.5 second and turns off for
0.5 second in a regular way.
When there is no fault, it is
steady off.

The fault can be queried through
the Auto Station.

LED5

PWR power
indicator (green)

supply

Itis steady on when the PLC card
is powered on.

LED6

RUN  running status

indicator (green)

It is steady on when the PLC
program runs.
It is steady off when the PLC
program stops.
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3 Secondary development platform

3.1 Auto Station introduction

INVT Auto-Control has developed the Auto Station as the secondary development platform of
PLC cards. You can download the Auto Station from http://www.invt-control.com/. Currently,
Auto Station V1.41 is used as the secondary development platform of the PLC card. You are
recommended to download Auto Station V1.41 or later.

If you have successfully installed the Auto Station, double-click the Auto Station. The interface
is displayed, as shown in the following:

W Auto Station - [m} x
Ele View PLC Tool Help

feHdd s hhjee [ malusE@IlvslrelbRolLa
OO+ + Y[ iEas]— L s 444 istd |0 Om [ — | 7=l

Project Manager o x Tree

Output Window X

v
H[4[»|m|"Compile 4 Communication A Comvertion AFind [< >
For help, press F1 [ [ [ovr]

Figure 3.1 Auto Station interface

3.2 PLC program download interface

If you want to download programs to the PLC card through the Auto Station, you need to
install the driver, use the mini-USB cable to connect the PLC card to the PC. If the driver
cannot be installed automatically, visit http://www.wch.cn/downloads/CH341SER_EXE.html
and download the CH341SER.EXE file for USB-serial port driver of PLC card. If you cannot
install it, contact INVT Auto-Control to obtain the driver and drive installation guide.
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After installing the driver, open the Auto Station. After creating a project, choose PLC
Communication > Connect, and choose Program Port Setting. Set related parameters.

Generally, you only need to select the serial port (for example, COMS5).

Connect PLC using: @) Serial () Ethernet () USE

Serial
Serial port: ry COMS ~
Baud rate: | 19200 ~

Set PC serial port and PLC serial port at
the same time.

Ethernet
Peer Device: IVC3 main module
Peer IP: 192 .168 . 1 . 10
Port: 9016
OK Cancel

Figure 3.2 Serial port setting for program download

3.3 How to edit programs on the Auto Station

1. After opening the Auto Station, choose File > New Project to create a project. Select IVC1L
as the PLC type since the PLC card uses the structure of the IVC1L programmable controller
developed by INVT Auto-Control. See the following figure.
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Program name [Test |

Location \PLC_INVT Test| .

PLC type vCiL 32
Default editor | Ladder chart v
Project | ‘
description
oK Cancel

Figure 3.3 Creating a project

You can also choose Tool > Options... to change the default editor (program editing

language), PLC type, and interface language. The new project is an IVC1L project by default.
See the following figure.

Project praperty
oK
Defaulteditor: | Ladder chart
Cancel
Default PLC e ~
LD optimization display

Right alignment | Screen right side

Designated o

Frogram Language
HRERE)[En-Us] 52

= Changes to language wil take effect
next time the program start,

Figure 3.4 Default option settings

The interface that is displayed after the project creation is as follows:
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B
Fle Edt Yiew Ladder PLC Debug Tool Window Hep

D@ AR LsEDav¥ra|dF ol 1.
GO0+ & [Pt o L = 2 B0 0OH[— | #b -

rojact Hanagar FX] [ mam | _a|v|x|[Tnstructon Tree T

= ] Test(vCIL) #-{LJ Basic Instruction

Variable addr. Variable Name |Variable Type |Data Type | Comments A

417 Program block - B 18] Program control instr.
MAIN TEMP Bt v || 5L Program contral instn.
o SR = @ ([ s7¢ im-um‘fu?»l
“ L N 3-{11) Data transmiddidd Thst
£ Global variable @) Integer math instructic
/2 Data block “ ] Flasting paint number
System block L) Accumulator instructio
4% Cross reference . (L] Word logic instruction
#6 Element monitos +441) Shify/rotate instruction
o Instruction Wiz Py + (L) Enhanced bit logic inst
¥ PLC Communical ‘\4@ w([] High-speed 10 instruc
i Control calculation inst
— + L) External equipment ins
(20 (L] Real-time clock instruc
o v || &L Compare date and tir
> < >
UEpUE Window T
= q4
L)
HLe v [n\Conpile { Comunication A Comvertion AFind < >
For help, press F1 OVR[Row: 1, Col: 1

Figure 3.5 New project interface
The interface can be divided into five areas:

Area (D: Menu and toolbar area. If you move the mouse over the toolbar area, the function of
the corresponding tool is displayed. You can choose View > Instruction List/Ladder/SFC to
change the program language. If a fault occurs, LED4 is blinking. You can choose PLC > PLC
Info... to view fault information and choose PLC > Clear PLC Error Information to clear fault
information. After the clearing, LED4 turns off. You can also choose Debug > Monitor to
monitor variables. In monitoring mode, you can directly modify readable and writable elements
to test programs. In addition, you can choose Help > Help Topic to view instruction
descriptions and typical instances.

Area @: Project manager. If you want to use the RS485 function, you need to configure
System Block > Serial Port. If you want to use the power-outage saving function, you need
to configure System Block > Saving Range. If you want to monitor variables in monitoring
mode, you need to configure Element monitoring table > EMT_1 or right-click the monitoring
table to add element monitoring tables such as EMT_2 and EMT_3. If you want to download
programs from the Auto Station to the PLC card or monitoring the running status, you need to
configure PLC Communication > Connect, select a serial port, and set related port
parameters.

Area ®: Instruction tree. The instruction tree enables you to select instructions to edit
secondary development programs.
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Area @: Program editing area. You can edit programs in this area after selecting a program
language.

Area ®): Information output area, in which information such as download, upload, and
monitoring information is output, for easy debugging and view.

2. After completing a PLC program, you can download the program to the PLC card by clicking
the download button on the toolbar. In case of power outage, the program is downloaded to
the flash memory. When the SW1 switch is turned to RUN, you can control the running and
stop of PLC programs by clicking the Run/Stop button on the toolbar of the Auto Station.

3. When the PLC card runs a user-defined program, you can connect to the Auto Station
through the mini-USB, and choose Debug > Monitor to monitor PLC card variables.
Double-click to choose Element monitoring table > EMT_1. In the window that is displayed,
enter to-be-monitored variables in the Element Name column. If the variables are readable
and writable, you can enter values in the New value column, right-click to choose Write
Selected Element to change the element status. See the following figure.

2 MAm | [E EMT_1 }

-Elemem: Name |data type display formal current value new value
Binary OFF
Binary oN
Decimal 100 100

Decimal

Figure 3.6 Monitoring mode
4. You can keep edited programs secret since the Auto Station also provides multi-level
security measures, which are described in the following.

Table 3.1 Security measures for user-defined programs

Security measure Description

After formatting is disabled in the system block and the system
block is downloaded to the PLC, the user-defined programs,
Disabling formatting system block, and data block in the PLC cannot be deleted by
means of formatting. To enable formatting, download the new
system block and enable formatting on the new system block.

Download password Used to restrict download.

If you select the option of disabling upload in the download dialog
box as you perform download, you cannot perform upload
Disabling upload regardless of whether you have the upload password.

To enable upload, re-download user data, and select the option of
enabling upload in the download dialog box.

Upload password Used to restrict the upload function.

Monitoring password Used to restrict the monitoring function.
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Security measure Description

You can set password to encrypt the main programs, sub
programs, and terminated sub programs. After being encrypted,
the program content cannot be viewed or edited. You can view
and edit such encrypted programs only after entering the correct
passwords.

Program password Encryption  method:  Right-click a  program, choose
Encrypt/Decrypt, enter a password, and confirm the password.
The program is encrypted.

Decryption method: Right-click an encrypted program, choose
Encrypt/Decrypt, and enter the correct password. The program
is decrypted.

5. To understand the instructions and soft elements for secondary development on the Auto
Station, see the IVC Series Micro-PLC Programming Manual developed by INVT Auto-Control.
The PLC card corresponds to IVC1L.
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4 Auto Station programming interfaces

The PLC card integrates the secondary development function by using the Auto Station. In
addition to the functions equipped with the PLC card, the entrance parameters required for
Auto Station programming also include the PLC card hardware functions, VFD hardware
functions, and VFD parameters. The output of Auto Station programming results is not only for
the internal use of the PLC card, but also for other control purposes such as controlling the
hardware output interfaces of the PLC card, the hardware output interfaces of the VFD, and
the start and stop commands of the VFD.

This chapter describes the relationship between the Auto Station secondary development,
PLC card, and VFD interfaces (including hardware and software instructions), with a focus on
Auto Station programming interfaces. The VFD related functions of Auto Station programming
interfaces are valid only when the SW1 is in Run state.

If not otherwise specified, all programming instructions use the LD programming system.
4.1 Importing and exporting interfaces

You can define programming interfaces and export the interface data to an Excel file. The
Auto Station can provide programming interfaces by importing the Excel interface file. INVT
provides a default programming interface file (an Excel file), which contains the interface
names and corresponding PLC elements (D elements). You can use D elements for
programming regardless of whether you import an Excel file. The default Excel file for GD350
programming interfaces is GD350_PLCcard_V100.xls.

In the Excel file, each variable is named in the format of I/C_xx, in which | indicates the
variable is sent to the PLC card through the VFD, while C indicates the variable is sent from
the PLC card to the VFD. In a word, the initial letter identifies the variable type.

The PLC card provides data storage elements of 8000 words, D0-D7999, in which
D7400-D7699 are defined as the VFD data transfer interfaces that have special meanings
corresponding to GD350 VFD parameters and therefore cannot be used as common storage
elements and the other D elements can be used as required.

The method of importing programming interfaces is as follows:

1. Double-click Global variable table on the Project Manager bar. In the opened global
variable table, choose File > |Import Global Variable. Then select
GD350_PLCCard_V100.xls.
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Ele Edit View PLC Tool Window

] New Project Ctr+N
% Open Project... Ctri+0
@ Save Project

Save Project As...
Close Project
Change PLC Type...
Save File Ctrl+5
Close File

Program File Export.

Program File Import...

Export Global Variable...
Import Global Variable...

Figure 4.1 Importing global variables

The imported global variable table is similar to the following:
= MAIN | £ Global variable table

Variable Name Variable addr Comments
1 I Setfrq 17400 VFD setting frequency
z I_OutputFrq 17401 VFD output frequency
3 I_LineSetFrq D7402 VFD ramp given frequenecy
4 I_DiState 7403 VFD switching input terminal status
g I_DoState 7404 VFD switching output terminal status
& I_TorqSet 17405 VFD torque reference
T I _Counter¥al 7406 VFD count ralue
5 I_AT1 D7407 VFD ATl input voltage
E] I_AT? D7408 VFD ATZ input voltage
10 I_ATS 7408 Expansion I0 card AT3 input voltage
11 I _HDIA Frg 7410 YFD HIT& input freguency
12 I HDIE Fraq I74lt YFI HOIE input frequency

Figure 4.2 Global variable table

When programming, you can directly use the variable names in the global variable table or
use the corresponding D elements (after D elements are written, the system automatically
replace the D elements with corresponding variable names). The following is an example of
saving the set frequency of the VFD to the element D100:

H1
T mv I SetFrq D100 ]

Figure 4.3 Programming example of using the global variable table
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If the global variable table is not imported, which indicates the table is empty, you can only use
D7400-D7599 for programming. The following is an example of saving the set frequency of
the VFD to the element D100:

ol K1
— MV 07400 ninn 1

Figure 4.4 Programming example of not using the global variable table

2. You can define a global variable table by yourself. That is, fill in the global variable table and
export the global variable table. Then the user-defined global variable table is saved. You can
import this global variable table when creating a project. Note that a variable name in the
global variable table cannot exceed 16 ASCII characters.

Note:

L] The prerequisite to import and export the global variable table is that the global variable
table window has been opened (to open the window, double-click the global variable
table in the project manager).

L] A limit is imposed on the number of variables in the global variable table that can be
downloaded to the PLC card. If there are too many variables defined in the global
variable table, the use is not affected, but some or all variables cannot be uploaded (at
this time, only the method described in this section can be used for import).

) After importing the global variable table, you need to choose View > Symbol

Addressing so that the D elements are displayed normally. Otherwise, the D elements
are displayed like "Dxxxx".

4.2 Interfaces for digital inputs and outputs

In addition to embedded I/O points, the PLC card can use VFD I/O points the since the card is
inserted into the VFD control board. (The specific I/O point quantity depends on the actual
product development.) You can define and use virtual I/O points, intermediate relays, and soft
elements on the Auto Station based on needs.

The following table lists the interfaces corresponding to the digital inputs and outputs of
GD350 and PLC card.

Table 4.1 Interfaces corresponding to the digital inputs and outputs of the VFD and PLC card

Auto Station VFD

interface DI/X/Y element function Interface description
variable name code

|_DiState D7403 P17.12 |_DiState is an unsigned 16-bit
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Auto Station
interface
variable name

D/X/Y element

VFD
function
code

Interface description

number, which is read only.

Each bit represents a unique digital
input terminal on the VFD:

Bit0: S1

Bitl: S2

Bit2: S3

Bit3: S4

Bit4: S5 (VFD I/O extension card
input terminal S5)

Bit5: S6 (VFD I/O extension card
input terminal S6)

Bit6: S7 (VFD I/O extension card
input terminal S7)

Bit7: S8 (VFD I/O extension card
input terminal S8)

Bit8: HDIA (for digital input)

Bit9: HDIB (for digital input)
Bit10-Bit15: Reserved

C_SetDo

D7626

C_SetDo is an unsigned 16-bit
number, which is readable and
writable.

Each bit represents a unique digital
output terminal of the VFD:

Bit0: Y1

Bitl: HDO (for digital output)

Bit2: Y2 (VFD I/O extension card
output terminal Y2)

Bit3: RO1

Bit4: RO2

Bit5: RO3 (VFD 1/O extension card
output terminal RO3)

Bit6: RO4 (VFD 1/O extension card
output terminal RO4)

Bit7-Bit15: Reserved

X0

X0

Digital input terminal PS1 on the
PLC card

X1

X1

Digital input terminal PS2 on the
PLC card
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Auto Station VED
interface D/X/Y element function Interface description

variable name coele

Digital input terminal PS3 on th

X2 X2 / p'Lgéiar'Spu ermina on the

Digital input terminal PS4 on th

X3 X3 / Pll_géacarlgpu ermina on the

Digital input terminal PS5 on th

X4 X4 / Pll_géacarlgpu erminal on the

Digital input terminal PS6 on th

X5 X5 / Pll_géacarlgpu erminal on the

Rel tput terminal PRO1 on th

YO YO / PfCa)::;rL(; put termina on the

Rel tput terminal PRO2 on th

Y1 Y1 / Pfcas::aorlcij put termina on the

1. You can apply a bit contact instruction to |_DiState to perform terminal control. (The bit
contact instruction is BLD, which can be found in the instruction tree. For details about how to

use instructions, see the IVC Series Micro-PLC Programming Manual.)

Mo
I_q/)_¢ ELD I DiState 1640 H o mov 1 C_CTEL 1

Figure 4.5 Using a bit contact instruction

This statement is used to get bit0 (16#0) of I_DiState, that is, to get the status of VFD input
terminal S1. If the bit is 1, 1 is written to C_CTRL, which is described later, the VFD runs
forward after setting P00.01=2 and P00.02=4 for the VFD.

2. You can use the following instructions to divide |_DiState into 16 bit-elements.

Mi00
mv I DiState K4MD ]

—{ mv 1 CLTRL ]

Figure 4.6 Word/bit conversion
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This program segment divides |I_DiState into 16 bit-elements, which are MO-M15. You can
operate the 16 bit-elements respectively. As shown in the figure, MO is checked. When MO is
connected (I_DiState Bit0=1), 1 is written to C_CTRL, the VFD runs forward if correct
channels have been set.

3. After setting correct channel parameters P06.00-P06.04, P26.00-P26.02, and
P26.04-P26.05, you can directly write a value to C_SetDo to control VFD output terminals.
For example, run the following instruction:

mion
Moy 241 C_Zetlo ]

Figure 4.7 Controlling VFD output terminals

In the instruction, 2#1 represents 0000001 in binary format, writing it to C_SetDo, which
means Bit0=1, indicates connecting the VFD output terminal Y1.

4. For I/O terminals on the PLC card, directly edit programs on X0—-X5 and YO-Y1.

10
—{ SET I ]

Figure 4.8 Programming for PLC card I/O terminals

The preceding instruction indicates that PRO1 (YO0) is connected when the PLC card PS1 (X0)
terminal is connected.

4.3 Interfaces for analog inputs and outputs

The VFD control board and PLC card provide a total of seven analog inputs and outputs for
Auto Station programming. (The number of analog input/output programming interfaces varies
depending on the actual product development.)

The following table lists the interfaces corresponding to the analog inputs and outputs of
GD350 and PLC card.
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Table 4.2 Interfaces corresponding to the analog inputs and outputs of the VFD and PLC card

Auto Station VFD
interface D element function Interface description
variable name code
0.00-10.00V/0.00-20.00mA. It is read
_AIL D7407 p17.19 | O

VFD analog input terminal All,
corresponding to 0—1000/0—1000

-10.00-10.00V. It is read only.
I_AI2 D7408 P17.20 VFD analog input terminal Al2,
corresponding to -1000-1000

0.00-10.00V/0.00-20.00mA. It is read

only.

I_AI3 D7409 P19.09 VFD 1/0 extension card analog input
terminal Al3, corresponding to
0-1000/0-1000
0.00-10.00V/0.00-20.00mA. It is
readable and writable.

C_SetA0L pre27 ! VFD analog output terminal AO1,
corresponding to 0-1000/0—1000
0.00-10.00V/0.00-20.00mA. It is
readable and writable.

C_SetAO2 D7628 / VFD I/0 extension card analog output

terminal AO2, corresponding to
0-1000/0-1000

C_SetAO3 D7629 / Reserved.

0-10.00V/0.00-20.00mA. It is read only.
To use the PLC card input terminal Al1,
you need to configure SM172, SM173,
and SM174. After the setting, the input
value (corresponding to
0-10000/0-10000) of the PLC card input
terminal All can be read from SD172 or
D7633(C_Ailval). The value is also
synchronized to P27.24.

For SM172, the value 1 indicates enabling
input, while the default value O indicates
disabling input.

For SM174, the value 1 indicates current
input, while the default value 0 indicates

C_Ailval D7633 P27.24
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Auto Station VFD
interface D element function Interface description
variable name code

voltage input.
SD173 specifies the sampling count.

0-10.00V/0.00-20.00mA. It is readable
and writable.

To use the PLC card input terminal AO1,
you need to configure SM178 and SM179.
After the setting, a value (corresponding
to 0-10000/0—10000) can be written to
SD178 to enable AOL1 to output current or
voltage. The value is also synchronized to
P27.25.

For SM178, the value 1 indicates enabling
output, while the default value 0 indicates
disabling output.

For SM179, the value 1 indicates current
output, while the default value 0 indicates
voltage output.

Note: D7634(C_Aolval) only has the
display function and cannot be used for
programming. That is, writing a value to
D7634(C_AolVal) does not change the
output value of AO1.

C_Ao1lval D7634 P27.25

1. Before setting the analog outputs of the VFD or I/O extension card, set the function codes
P06.14 and P26.35. After values are written to C_SetAO1 (D7627) and C_SetAO2 (D7628),
corresponding analog values can be output on the VFD or I/O extension card.

2. The program for configuring PLC card analog input terminal All is as follows:

Mmoo

SET STz ]
SET SMT4 ]
my 5 sD17E ]

Figure 4.9 Input configuration for Al1 on the PLC card
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The program indicates that Al1 input is enabled, current input is selected (J2 connected to Al),
and the sampling count is 5. The input current (corresponding to 0—-10000) of Al1 can be read
from SD172 or D7633(C_AilVal).

3. The program for configuring PLC card analog output terminal AO1 is as follows:

W10
SET Sm7E ]

RST  SWTR )

Figure 4.10 Output configuration for AO1 on the PLC card

The program indicates that AO1 output is enabled, and voltage output is selected (J5
connected to AVO). The output value of AO1 can be provided by writing a value to SD178 and
can be obtained through D7634(C_Ao1Val).

4.4 Interfaces for control commands and function commands

In addition to the digital/analog input/output terminals for Auto Station programming,
communication commands can be used to control the VFD. Compared with terminal functions,
communication commands are less and mainly used to control the startup and stop of the VFD.
The following describes the control commands that Auto Station provides for the VFD.

1. Basic control commands

Auto Station control commands equal communication based control commands. Therefore,
P00.01 must be set to 2 (communication command) for the VFD, and P00.02 must be set to 4
(PLC card) for the VFD.

Table 4.3 Basic control command interface

Auto Station VFD
interface D element function Interface description
variable name code

0-10. It is readable and writable.
The options are as follows:
Disable

Run forward (FWD)

Run reversely (REV)

Jog forward

Jog reversely

Decelerate to stop

Coast to stop

Reset the fault

C_CTRL D7600 /

NoahkwNhREOQ
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Auto Station VFD
interface D element function Interface description
variable name code

8: Quick and emergency stop
9: Reserved
10: Reserved

Before using a control command, you need to note: If a running command is given during
power-on (without completing initialization) or re-running, the VFD enters the running
protection state. In this case, the VFD will not run until the running command is revoked and
a new running command is given. (To disable running protection, stop the VFD.)

To prevent the VFD from entering the running protection state during power-on, it is
recommended that the running command be given with a delay of 500ms—1000ms after
power-on.

Re-running indicates: When the VFD is running, the RUN/STOP switch on the PLC card is
switched from STOP to RUN or the RUN/STOP button on the Auto Station monitoring
interface is switched from STOP to RUN. If the running command is not revoked, the VFD also
enters the running protection state.

During normal running, the RUN/STOP switch on the PLC card will not be turned to STOP or
the STOP button on the Auto Station monitoring interface will not be clicked. However, during
code debugging, the resumable operation may be performed, and you must pay attention to
whether running protection is enabled.

2. Multi-step speed command

Table 4.4 Multi-step speed command interface

Al_Jto Station VED
mtelrface D element function Interface description
variable
name code
0-16. It is readable and writable.
The options are as follows:
0: Disable
1: Multi-step speed 0
2: Multi-step speed 1
C_MFrq D7601 ! 3: Multi-step speed 2
4: Multi-step speed 3
5: Multi-step speed 4
6: Multi-step speed 5
7: Multi-step speed 6
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Auto Station

interface VFD
. D element function Interface description
variable
code
name

8: Multi-step speed 7

9: Multi-step speed 8
10: Multi-step speed 9
11: Multi-step speed 10
12: Multi-step speed 11
13: Multi-step speed 12
14: Multi-step speed 13
15: Multi-step speed 14
16: Multi-step speed 15

The multi-step speed setting cannot be greater than 16. The value 0 cannot be used, while the
default value is 1. This command is only used for channel selection. Each multi-step speed
must be set through P10 and require the setting of P00.06/P00.07.

3. ACC/DEC time setting command

Table 4.5 ACC/DEC time setting command interface

N ovrtace
. D element function Interface description
variable
code
name
0-4. It is readable and writable.
The options are as follows:
0: ACC/DEC time 1
c_SpT D602 ! 1: ACC/DEC time 2
2: ACC/DEC time 3
3: ACC/DEC time 4

The value cannot be greater than 3. The default value is 0. This command is only used for
channel selection. ACC/DEC time has to be set through the respective function codes.

4.5 Interfaces for setting function parameters

The VFD provides the PLC card with certain function parameter interfaces. You can set these
parameters on the Auto Station.
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Table 4.6 Interfaces for setting VFD function parameters

Auto Station VFD
interface D element function
variable name code

Interface description

C_FRQ_SET D7603 /

0-63000 (corresponding to 0—-630.00Hz).
It is readable and writable.

To enable the PLC card to set the VFD
frequency, set P00.06/P00.07=14.

C_TOR_SET D7604 /

-3000-3000 (corresponding to
-300.0%-300.0%). It is readable and
writable.

To enable the PLC card to set the VFD
torque, set P03.11=12 and P03.32=1.

C_F_UP_FWD D7605 /

0-63000 (corresponding to 0—630.00Hz).
It is readable and writable.

To enable the PLC card to set forward
torque upper limit, set P03.32=1, P00.00
to a value rather than 2, and P03.14=11.

C_F_UP_REV D7606 /

0-63000 (corresponding to 0—-630.00Hz).
It is readable and writable.

To enable the PLC card to set reverse
frequency upper limit, set P03.32=1,
P00.00 to a value rather than 2, and
P03.15=11.

C_T_UP_ELEC D7607 /

0-3000 (corresponding to 0—300.0%). It is
readable and writable.

To enable the PLC card to set
electromotion torque upper limit, set
P03.32=1, P00.00 to a value rather than
2, and P03.18=10.

C_T_UP_GEN D7608 /

0-3000 (corresponding to 0-300.0%). It is
readable and writable.

To enable the PLC card to set braking
torque upper limit, set P03.32=1, P00.00
to a value rather than 2, and P03.19=10.

C_ACC1 D7609 /

0-36000 (corresponding to 0-3600.0s). It
is readable and writable.

When VFD ACC time 1 is set to a value
rather than O through the PLC card, ACC
time 1 specified by the value is forcibly
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Auto Station
interface
variable name

D element

VFD
function
code

Interface description

used (P00.11 is invalid). When VFD ACC
time 1 is set to O through the PLC card,
ACC time 1 (P00.11) set through the VFD
keypad is used.

C_DEC1

D7610

0-36000 (corresponding to 0-3600.0s). It
is readable and writable.

When VFD DEC time 1 is set to a value
rather than 0 through the PLC card, DEC
time 1 specified by the value is forcibly
used (P00.12 is invalid). When VFD DEC
time 1 is set to O through the PLC card,
DEC time 1 (P00.12) set through the VFD
keypad is used.

C_PID_GV_S

D7612

-1000-1000 (corresponding to
-100.0-100.0%). It is readable and
writable.

To enable the PLC card to set the VFD
PID reference value, set P00.00 to a value
rather than 2, P00.06=7 and P09.00=11.

C_PID_FB_S

D7613

-1000-1000 (corresponding to
-100.0-100.0%). It is readable and
writable.

To enable the PLC card to set the VFD
PID feedback value, set P00.00 to a value
rather than 2, P00.06=7 and P09.02=9.

C_VF_SET

D7624

0-1000 (corresponding to 0-100.0%). It is
readable and writable.

To enable the PLC card to set the VFD VF
voltage, set P04.00=5 (user-defined V/F)
and P04.27=12.

C UP_FRQ

D7625

Frequency upper limit. Reserved.

C_DiState

D7631

P27.22

0-0x3F. Itis read only.

PLC card digital input terminal status.
Bit5-Bit0 represent PS6-PS1
respectively.

C_DosState

D7632

P27.23

0-0x3. Itis read only.

PLC card digital output terminal status.
Bit0O represents PRO1, and Bitl
represents PRO2.
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4.6 Interfaces for viewing function parameters and VFD status

1. Viewing function parameters

The VFD opens function groups P17 and P18 and certain variables in groups P19 and P27 for
the PLC card. You can use Auto Station interfaces to check VFD function parameters (the
interfaces vary depending on the actual product development).

The following table lists the interfaces for viewing GD350 function parameters. For details
about the function parameters, see GD350 operation manual.

Table 4.7 Interfaces for viewing function parameters (group 1)

Auto Station VFD
interface D element | function Interface description
variable name code
|_SetFrq D7400 P17.00 Set frequency of the VFD. It is read only.
Output f f the VFD. It i d
I_OutputFrq D7401 pi7.o1 | Duputirequency of the s red
only.
) R f f f the VFD. It
I_LineSetFrq D7402 p17.02 | [amp reerence lrequency ot the
is read only.
| DoState D7404 P17.13 D|.g|tal output terminal status of the VFD.
- Itis read only.
T f | f the VFD. It i
I|_TorgSet D7405 P17.15 orque reference value of the is
read only.
|_CounterVal D7406 P17.18 Count value of the VFD. Itis read only.
|_HDIA_Frq D7410 P17.21 HDIA input frequency of the VFD. It is
read only.
HDIB input f f the VFD. It i
|_HDIB_Frq D7411 P17.22 iNput frequency of the s
read only.
|_PID_Set D7412 P17.23 PID reference value. Itis read only.
|_PID_Feedback D7413 P17.24 PID feedback value. It is read only.
|_PID_Output D7414 P17.38 Process PID output. It is read only.
|_EncoderFrg D7415 P18.00 Actual frequency of the encoder. It is
- read only.
| CardEnable D7416 P27.00 Indlcates_ whether to en_able the PLC
- card, which is reserved. It is read only.
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Table 4.8 Interfaces for viewing function parameters (group 2)

Auto Station VFD
interface D element function Interface description
variable name code
|_OutputVolt D7500 P17.03 Output voltage. It is read only.
|_OutputCurrent D7501 P17.04 Output current. It is read only.
|_MotorRpm D7502 P17.05 Motor speed. It is read only.
|_TorgCurrent D7503 P17.06 Torque current. It is read only.
I_MagCurrent D7504 P17.07 Exciting current. It is read only.
|_MotorPower D7505 P17.08 Motor power. It is read only.
|_OutputTorq D7506 P17.36 Output torque. It is read only.
|_EstMotorFrg D7507 P17.10 cIfslt)l/r.nated motor frequency. It is read
I_DC_Volt D7508 P17.11 DC bus voltage. It is read only.
|_LineSpeed D7509 P17.16 Linear speed. It is read only.
|_PowerFactor D7510 P17.25 Motor power factor. It is read only.
|I_CurRuntime D7511 P17.26 Current running time. It is read only.
|_CurStage D7512 p17.27 Simple PLC and cgrrent step number of
multi-step speed. It is read only.
|_SynMagAngle D7513 P17.29 Pole angle of open-loop synchronous
motor. It is read only.
|_MagCurSet D7514 P17.33 Exciting current reference. It is read only.
|_TorqCurSet D7515 P17.34 Torgue current reference. It is read only.
|_LineAC_Cur D7516 P17.35 AC incoming current. It is read only.
|_MotorOutTorq D7517 P17.09 Motor output torque. It is read only.
|_CtriMode D7545 P17.40 Motor control mode. It is read only.
I|_TorqUpElec D7546 p17.41 Electromotion torque upper limit. It is
read only.
|_TorgUpGen D7547 P17.42 Braking torque upper limit. It is read only.
I TorqFrqUpFwd D7548 p17.43 Frequency upper Iimit of forward running
in torque control. It is read only.
| TrogFrqUpRev D7549 p17.44 Frequency upper Iimit of reverse running
in torque control. It is read only.

2. Viewing temperatures and faults

The VFD allows the PLC card to read temperature display, power class, and fault display. You
can use the Auto Station interfaces to view the information (the interfaces vary depending on
the actual product development).
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The following table lists the interfaces for viewing GD350 temperatures and faults. For details
about the function parameters, see GD350 operation manual.

Table 4.9 Interfaces for viewing temperatures and faults

Auto Station VFD
interface D element | function Interface description
variable name code
LT _Sink D7518 PO7.11 Rectifier bridge module temperature. It is
read only.
U T Invert D7519 PO7.12 Inverting module temperature. It is read
— only.
| InvertRuntime D7520 PO7.14 Accumulative running time. It is read
~ only.

MSB of VFD electricit tion. It i
|_ElectricHigh D7521 P07.15 sBo electricity consumption. 1L 1s
- read only.

LSB of VFD electrici tion. It
I_ElectricLow D7522 poz.16 | W8 O electricity consumption. t is
- read only.
|_FaultType D7523 P07.27 Type of present fault. It is read only.

R ing fi t t t fault. It
|_FaultRunFrg D7524 po7.33 | unningirequency atmostrecenttau

is read only.

. R f fi t t
|_FaultLineFrq D7525 P07.34 amp  reterence irequency at mos
recent fault. It is read only.
tput volt t t t fault. It i
|_Faultoutvolt D7526 po7.35 | Output voltage at most recent fault. It is
read only.

Output current at most recent fault. It is
I_FaultoutCur D7527 P07.36 P

read only.

B | fault. 1t i
| EaultDeVolt D7528 PO7.37 us voltage at most recent fault. It is
- read only.

Max. fault. |
|_FaultTemper D7529 P0O7.38 : ax. temperature at most recent fault. It
- is read only.

| FaultDi D7530 P07.39 Input terminal status at most recent fault.
_ Itis read only.

| EaultDo D7531 P07.40 Output_termlnal status at most recent
- fault. It is read only.

3. Viewing VFD current status and parameters

The VFD allows the Auto Station to invoke the VFD status and some other parameters, some
of which are the same as corresponding parameters in group P17.
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Table 4.10 Interface for viewing VFD current status and parameters

Auto Station VFD
interface D element | function Interface description
variable name code

VFD status 1. It is read only.
1: In forward running

2: In reverse running

3: Stopped

4: Faulty

5: PoFF

I_InvtStatel D7532 /

VFD status 2. It is read only.

Bit0: =0: Not ready to run =1: Ready to
run

Bit1-Bit2: =00: Motor 1=01: Motor 2 =10:
Motor 3 =11: Motor 4

Bit3: =0: Asynchronous motor =1:
Synchronous motor

Bit4: =0: No overload alarm =1: Overload
alarm

Bit5-Bit6: =00: Keypad-based control
I_InvtState2 D7533 / =01: Terminal-based control =10:
Communication-based control

Bit7: Reserved

Bit8: =0: Speed mode =1: Torque mode
Bit9: =0: Non position mode =1: Position
mode

Bit10-Bit1l: =00: Without-PG vector
control mode 0 =01: Without-PG vector
control mode 1 =10: Closed-loop vector
control mode =11: V/F control mode
Bit12—Bit15: Reserved

I_InvtErrCode D7534 / VFD fault code. It is read only.

4.7 PLC-defined fault interface

The PLC card defines 10 faults that can be used for the secondary development on the Auto
Station. These PLC-defined faults will be sent back to the VFD and shown as external faults
on the VFD panel. The symbol for these faults is C_P_Err (DSP fault code display also
synchronized). See the following table for the faults.
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Table 4.11 PLC Card-defined fault interface

Auto Station
interface
variable name

D element

VFD
function
code

Interface description

C_P_Err

D7611

PLC-defined fault on the PLC card. It is
readable and writable.

No fault (fault cleared)

PLC Card-defined fault 1

PLC Card-defined fault 2

PLC Card-defined fault 3

PLC Card-defined fault 4

PLC Card-defined fault 5

PLC Card-defined fault 6

PLC Card-defined fault 7

PLC Card-defined fault 8

PLC Card-defined fault 9

10: PLC Card-defined fault 10

The C_P_Err fault code ranges from 1 to
10. A fault code greater than 10 is
invalid.

©XNOAR®WNREOQ

The VFD stops once a PLC Card-defined fault occurs. To resume the running, reset the fault
(the method for handling a PLC Card-defined fault is similar to that for handling a VFD fault.)
Pay attention to the following during programming: If the fault condition disappears, remove
the fault immediately; otherwise, reset cannot be performed. The VFD only displays one fault,
which means that the VFD does not report another fault when the VFD has reported one fault.

4.8 Interfaces for writing data

The VFD provides a group of parameters configurable so that you can enable the VFD to write
data to the PLC card.

You can write data to the parameters on the PLC card by setting VFD P27 function codes (that
is, you can invoke P27 function code interfaces through the Auto Station to assign values to
variables.) You can define 10 interfaces for writing data to the PLC card.

Table 4.12 Interfaces for writing data to the PLC card

Auto Station VFD
interface D element | function Interface description
variable name code
| WPl D7535 p27.01 Value that thg VFD writes to WrP1 on the
- PLC card. Itis read only.
|_WrpP2 D7536 P27.02 Value that the VFD writes to WrP2 on the
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Auto Station VFD
interface D element | function Interface description
variable name code
PLC card. Itis read only.

| WrP3 D7537 p27.03 Value that thg VFD writes to WrP3 on the
- PLC card. Itis read only.

| WrP4 D7538 P27.04 Value that thg VFD writes to WrP4 on the
- PLC card. Itis read only.

| WrP5 D7539 P27.05 Value that thg VFD writes to WrP5 on the
- PLC card. Itis read only.

| WrP6 D7540 P27.06 Value that thg VFD writes to WrP6 on the
— PLC card. It is read only.

| WrP7 D7541 P27.07 Value that thg VFD writes to WrP7 on the
- PLC card. It is read only.

| WP D7542 P27.08 Value that thg VFD writes to WrP8 on the
- PLC card. It is read only.

| WrP9 D7543 P27.09 Value that thg VFD writes to WrP9 on the
- PLC card. Itis read only.

| WrP10 D7544 P27.10 Value that the YFD writes to WrP10 on
- the PLC card. Itis read only.

4.9 Interfaces for monitoring PLC card data

The VFD provides a group of function codes for the PLC card to monitor PLC card data.

You can perform secondary development on the Auto Station to send to-be-monitored PLC
card data to Auto Station programming interfaces corresponding to P27. The VFD can monitor
the data through P27. A total of 10 Auto Station interfaces can be defined.

Table 4.13 Interfaces for monitoring PLC card data

Auto Station VFD
interface D element | function Interface description
variable name code
C MoP1 D7614 P27.12 MoP1 value moh|tored by the VFD. It is
- readable and writable.
C MoP2 D7615 P27.13 MoP2 value mop|t0red by the VFD. It is
- readable and writable.
MoP: | i he VFD. It i
C MoP3 D7616 p27.14 oP3 value mopltored by the tis
- readable and writable.
MoP4 val i he VFD. Iti
C MoP4 D7617 P27.15 oP4 value mopltored by the tis
- readable and writable.
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Auto Station VFD
interface D element | function Interface description
variable name code
C MoP5 D7618 P27.16 MoP5 value mop|t0red by the VFD. It is
- readable and writable.
C MoP6 D7619 P2717 MoP6 value mop|t0red by the VFD. It is
- readable and writable.
C MoP7 D7620 P27.18 MoP7 value mop|t0red by the VFD. It is
- readable and writable.
C MoP8 D7621 P27.19 MoP8 value mop|t0red by the VFD. It is
- readable and writable.
C MoP9 D7622 P27.20 MoP9 value mo_n|t0red by the VFD. It is
- readable and writable.
C MoP10 D7623 p27.21 MoP10 value m9n|t0red by the VFD. Itis
- readable and writable.

4.10 RUN/STOP switch and PLC card running status

The RUN/STOP switch on the PLC card is used to start or stop the PLC program and does not
affect PLC program download. If the switch is turned to STOP, the PLC program is stopped. If
the switch is turned to RUN, the PLC program runs. The status can be viewed through P27.11.
If the switch is turned from RUN to STOP, the control command given to the VFD is cleared (if
the VFD is running, the VFD stops at this situation), hardware output (including VFD
AO1/AO2/RO1/RO2/Y1/Y2 and PLC card PRO1/PRO2/AO1/External fault) is cleared. If the
switch is turned from STOP to RUN, output is executed with a delay of 0.5s.

Table 4.14 Description of SW1 on the PLC card

Swi Function Description
PLC programs are executed. If the
RUN To run PLC switch is turned from STOP to RUN,
programs output is executed with a delay of
0.5s.
sTOP To sto PLC Stopping PLC programs will clear
programs PLC output.

Output of the PLC card indicates the control command that the PLC card sends to the VFD.

Hardware output includes VFD AO1/AO2/RO1/RO2/Y1/Y2 and PLC card
PRO1/PRO2/A01/External fault.

1. If the RUN/STOP switch is turned to STOP: if the Auto Station is being used for monitoring

now, the RUN button on the Auto Station is invalid and turned to the STOP state; if the

RUN/STOP button on the Auto Station is turned to STOP during the online monitoring
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debugging, PLC programs are suspended, PLC output is cleared, and the VFD coasts to stop.

2. If the RUN/STOP switch is turned to RUN: if the Auto Station is being used for monitoring
now, the RUN/STOP button on the Auto Station is valid and turned to the RUN state; PLC
programs resume running, but the hardware PLC output activates with a delay of 0.5s, and the
running command that is given to the VFD again (the VFD not in running protection state) also
activates with a delay of 0.5s.

The correct operation procedure is as follows: Before downloading programs from the Auto
Station to the PLC card, turn the RUN/STOP switch on the PLC card to STOP. After the
download, turn the RUN/STOP switch on the PLC card to RUN. In addition, you can debug
code online and perform monitoring and use the RUN/STOP button on the Auto Station to
perform control the output of the PLC card.

You can enable the monitoring mode of the Auto Station or check the value of VFD function
code P27.11 to view the running status of the PLC card.

Table 4.15 Interface for viewing the running status of the PLC card

Auto Station VFD
interface D element | function Interface description
variable name code
It displays the current running status of
C_RunStopState D7630 paray | e PLCcard. Itisread only.
0: Stopped
1: Running

4.11 DP/CANopen/PN communication channel

The VFD uses function code P27.26 to control the data volume (send by 2 groups) exchanged
between the PLC card and VFD to reduce communication time. By default, P27.26 is 0x03,
indicating only the data exchanged through the interfaces mentioned earlier is involved. If you
want to enable the DP/CANopen/PN communication channel for the PLC card, change the

value of P27.26 accordingly.
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Table 4.16 Description of function code P27.26

Function
code

Function
name

Description

Default

Modify

P27.26

Length of data
sent from the
PLC card and
PzZD
communication
object

0x01-0x28

Ones place: Volume of data sent
from the PLC card. The number of
variables in the sending table is
12*Ones place.

3: VFD send 24+60 variables,
while PLC card send 36 variables.
This value indicates the default
variable transfer method of
GD350.

5: VFD send 48+60 variables,
while PLC card send 60 variables.
This value indicates the PLC card
on GD350 communicates with the
DP/CANopen/PN card by using
(24+24) PZDs.

8: VFD send 96+96 variables,
while PLC card send 96 variables.
If this value is used, all variables
(including reserved variables) are
transferred mutually.

You can set the volume of data
sent from the PLC card to another
value, but you need to know the
corresponding variables. Setting
the ones place to another value
only changes the PLC sending
table data quantity (12*Ones
place), which means the VFD
send 24 + 60 variables by default.
Tens place: Communication card
with which the PLC card
exchanges PZDs. (It is valid only
when the ones place is 5.)

0: DP card

1: CANopen card

2: PN card

0x03
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Function Function

Description Default Modif
code name P Y

Note: P27.26 can be changed at
any time, but the change takes
effect only after re-power on.

The following describes the communication channel between the PLC card and
DP/CANopen/PN card. The PLC card defines two groups of PZD channel, used for writing and
read, and each group has 24 PZD channels. The writing channels are used to send data from
the DP/CANopen/PN card to the PLC card for secondary programming and then send the
processed data to the VFD. The reading channels are used to send data from the VFD to the
PLC card for secondary programming and then send the processed data to the

DP/CANopen/PN card. The following figure shows how the data is transferred.

Hostcomputer

DP/CANopen/PN Card

12 write PZD ‘| 12 read PZD
A 24 read PZD

' “| PLCcard

24 write PZD

Figure 4.11 Data transfer between the PLC card and DP/CANopen/PN card

As shown in the figure, the host computer sends data by using the writing channels.

(O The host computer sends data to the DP/CANopen/PN card.

@ After parsing the data from the host computer, the DP/CANopen/PN card encapsulates the
data into frames and sends the frames to PZD1-12 on the DSP. This group of PZD are
transferred to the corresponding elements D7424-D7435 (corresponding to Auto Station
interface variables |_WrSend_PZD1-I_WrSend_PZD12) on the PLC card.

® You can use the Auto Station to perform secondary programming on D7424-D7435
(corresponding Auto Station interface variables |_WrSend_PZD1-I_WrSend_PZD12) on the

PLC card. After the processing, the data is sent to D7636—-D7647 (corresponding to Auto
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Station interface variables C_WrRece_PZD1-C_WrRece_PZD12). Then the PLC card sends
this group of D elements to the DP/CANopen/PN card parsing program on the DSP for
parsing.

As shown in the figure, the host computer receives data by using the reading channels.

(@ The DSP sends data to the PLC card by using D7436-D7447 (corresponding to Auto
Station interface variables |_RdSend_PZD1-I_RdSend_PZD12).

@ You can use the Auto Station to perform secondary programming on D7436-D7447
(corresponding to Auto Station interface variables |_RdSend_PzZD1-I_RdSend_PZD12). After
the processing, the data is sent to D7648-D7659 (corresponding to Auto Station interface
variables C_RdRece_PZD1-C_RdRece_PzZD12). Then the PLC card sends this group of D
elements to the DSP channels for communication with the DP/CANopen/PN card.

@ After receiving the data, the DP/CANopen/PN card sends the data to the host computer.
The following table describes the channel interfaces.

Table 4.17 PZD writing channel interfaces

Auto Station VFD
interface variable D element | function Interface description
name code

Control word (CW), which is the first

I_WrSend_PZD1 D7424 / PZD sent from the DP/CANopen/PN
card

| WrSend_PZD2 D7425 / PZD2 sent from the DP/CANopen/PN
card

| WrSend PZD3 D7426 / PZD3 sent from the DP/CANopen/PN

- - card

| WrSend PZD4 D7427 / PZD4 sent from the DP/CANopen/PN

- - card

| WrSend PZD5 D7428 / PZD5 sent from the DP/CANopen/PN

- - card

| WrSend PZD6 D7429 / PZD6 sent from the DP/CANopen/PN

- - card

| WrSend PZD7 D7430 / PZD7 sent from the DP/CANopen/PN

- - card

| WrSend PZD8 D7431 / PZD8 sent from the DP/CANopen/PN

- - card

| WrSend_PZD9 D7432 / CP;I;Q sent from the DP/CANopen/PN
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Auto Station VFD
interface variable D element | function Interface description
name code

| WrSend PZD10 D7433 / PZD10 sent from the DP/CANopen/PN

~ - card

| WrSend_PZD11 D7434 / PZD11 sent from the DP/CANopen/PN
card

| WrSend_PZD12 D7435 / PZD12 sent from the DP/CANopen/PN
card

C_WrRece_PZD1 D7636 / CW sent to the VFD

C_WrRece_PZD2 D7637 / PZD2 sent to the VFD

C_WrRece_PZD3 D7638 / PZD3 sent to the VFD

C_WrRece_PZD4 D7639 / PZD4 sent to the VFD

C_WrRece_PZD5 D7640 / PZD5 sent to the VFD

C_WrRece_PZD6 D7641 / PZD6 sent to the VFD

C_WrRece_PZD7 D7642 / PZD7 sent to the VFD

C_WrRece_PZD8 D7643 / PZD8 sent to the VFD

C_WrRece_PZD9 D7644 / PZD9 sent to the VFD

C_WrRece_PZD10 D7645 / PZD10 sent to the VFD

C_WrRece_PZD11 D7646 / PZD11 sent to the VFD

C_WrRece_PZD12 D7647 / PZD12 sent to the VFD

Note: The preceding parameters require the setting of function groups P15 and P16. For

details, see INVT Communication Extension Card Operation Manual and Goodrive350 Series

High-performance Multi-function VFD. For example, if you want to set the frequency for the
VFD through the DP card, set P27.26=0x05 and P15.02=1, and set PZD2 to the required

value (and pay attention to the decimal place and unit conversion) on the host computer. Then

the set frequency is transferred to |_WrSend_PZD2 (D7425). If |_WrSend_PZD2 (D7425) is

directly sent to C_WrRece_PzZD2 (D7637), the set frequency is enabled on the VFD. If
I_WrSend_PzD2 (D7425) is sent to C_WrRece_PzZD2 (D7637) after being processed, the

processed set frequency is enabled on the VFD.

Table 4.18 PZD reading channel interfaces

Auto Station VFD
interface variable D element | function Interface description
name code
|_RdSend_PZD1 D7436 / Status word (SW), which is the first PZD

sent from the VFD
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Auto Station VFD
interface variable D element | function Interface description
name code
|_RdSend_PZD2 D7437 / PZD2 sent from the VFD
|_RdSend_PzD3 D7438 / PZD3 sent from the VFD
|_RdSend_PZD4 D7439 / PZD4 sent from the VFD
|_RdSend_PzD5 D7440 / PZD5 sent from the VFD
|_RdSend_PzZD6 D7441 / PZD6 sent from the VFD
|_RdSend_PZD7 D7442 / PZD7 sent from the VFD
|_RdSend_PzD8 D7443 / PZD8 sent from the VFD
|_RdSend_PZD9 D7444 / PZD9 sent from the VFD
|_RdSend_PZD10 D7445 / PZD10 sent from the VFD
|_RdSend_PzZD11 D7446 / PZD11 sent from the VFD
|_RdSend_PzZD12 D7447 / PZD12 sent from the VFD
C_RdRece_PZD1 D7648 / SW sent to the DP/CANopen/PN card
C_RdRece_PZD2 D7649 / PZD2 sent to the DP/CANopen/PN card
C_RdRece_PZD3 D7650 / PZD3 sent to the DP/CANopen/PN card
C_RdRece_PzZD4 D7651 / PZD4 sent to the DP/CANopen/PN card
C_RdRece_PZD5 D7652 / PZD5 sent to the DP/CANopen/PN card
C_RdRece_PZD6 D7653 / PZD6 sent to the DP/CANopen/PN card
C_RdRece_PzZD7 D7654 / PZD7 sent to the DP/CANopen/PN card
C_RdRece_PZD8 D7655 / PZD8 sent to the DP/CANopen/PN card
C_RdRece_PZD9 D7656 / PZD9 sent to the DP/CANopen/PN card
C RdRece PZD10 D7657 / PZD10 sent to the DP/CANopen/PN
- - card
C RdRece PZDI1 D7658 / PZD11 sent to the DP/CANopen/PN
- - card
C_RdRece_PZD12 D7659 / (I;Z:le sent to the DP/CANopen/PN

Note: The preceding parameters require the setting of function groups P15 and P16. For
details, see INVT Communication Extension Card Operation Manual and Goodrive350 Series
High-performance Multi-function VFD. For example, if you want to enable the DP card to read
the set frequency of the VFD, set P27.26=0x05 and P15.13=2. Then the VFD transfers the set
frequency to I_RdSend_PzZD2 (D7437). If |_RdSend_PzZD2 (D7437) is directly sent to
C_RdRece_PZD2 (D7649), the set frequency of the VFD is read from PZD2 of the host
computer. If |_RdSend_PZD2 (D7437) is sent to C_RdRece_PZD2 (D7649) after being

processed, the processed set frequency of the VFD is read from PZD2 of the host computer.
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4.12 RS485 communication and power-outage saving

1. RS485 communication

The PLC card designs a channel of RS485 communication, for which you can set the
parameters such as master/slave mode, port number, and baud rate through the Auto Station.
In addition, the Auto Station allows Modbus-RTU communication. For details about
Modbus-RTU, see Goodrive350 Series High-performance Multi-function VFD or visit the
Internet for related reference.

For details about RS485 communication, see chapter 5 for typical RS485 communication case
or see IVC Series Micro-PLC Programming Manual developed by INVT Auto-Control.

2. Power-outage saving

The PLC card provides a power-outage saving zone (flash memory) about 1K words. When
encountering a power outage, the VFD sends a power outage signal to the PLC card. After
receiving the signal, the PLC card saves data about the elements in the power-outage saving
range already specified on the Auto Station (note that the power-outage saving range can take
effect only after being downloaded to the PLC card). After re-power on, the data about the
elements in the power-outage saving range is automatically read and restored to the
corresponding elements. The power-outage saving function is applicable to the M, S, D, and C
elements.

Note: The power-outage saving function is not applicable to D7400-D7699, which are
variables exchanged with the VFD. To protect the values of D7400-D7695 at a power outage,
assign the values of this segment to other 7700 D elements in advance, and enable
power-outage saving for the D elements assigned with these values. After re-power on, you
can assign these values that are saved at power outage to D7400-D7699.

The method for configuring the power-outage saving function is as follows:

Double-click Saving Range under System block in the Project Manager. By default, the
Auto Station already has a saving range, which can be cleared for new setting. Note: The

saving range can take effect only after being downloaded to the PLC card.
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Default value
Group 1
Element Starting postion for Mumber of
type saving Hlement Bements saved
M 0 = 0 =
- = Clear
St 0 = 0 =
- S Clear
D: 100 = 00 =
- = Clear
C: 0 = 0 =
- S Clear
T < 0 E Clear

Figure 4.12 Setting a saving range

As shown in the preceding figure, the saving range is the 1000 D elements D100-D1099. For
details about power-outage saving, see IVC Series Micro-PLC Programming Manual

developed by INVT Auto-Control.
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5 Programming cases

5.1 For PLC card digital input/output terminals

Requirement: When the PS1 terminal of the PLC card has an input signal, the RO1 terminal of
the VFD has output. When both the S2 and S3 terminals of the VFD have an input signal, the
RO2 terminal of the VFD has output.

Implementing method: The LD is used for programming.

VFD function code setting: P06.03=44 (RO1 is given by the PLC card) and P06.04=45 (RO2 is
given by the PLC card)

The following figure shows the code example and online debugging result:

24 24
X0
| W { WR  C_Setlo 1643 C_Setle |
24 24
X0
| 4 WAMD C_Setho  IG¥FFF7  C_SetDo |
& &
Mmoo
MoV T_DiState K4MD ]
24 24
i} w
| B VWOR  C_SetDo 16410 [ Setla ]
24 24
i}
WAKD  C_Setlo  1GHFFEF  C_Setlo ]
Mz

Figure 5.1 Programming case for PLC card digital input/output terminals

5.2 For terminal-based running/fault control

Requirement: When the PS5 terminal on the PLC card has an input signal, the VFD runs
forward. When the PS6 terminal on the PLC card has an input signal, the VFD runs reversely.
When a fault occurs, the fault can be reset through input to the S3 terminal on the VFD. When
the S4 terminal on the VFD has input, external PLC fault 5 occurs.

Implementing method: The LD is used for programming. The programming logic is as follows:
Run forward=PS5, Run reversely=(!PS5)&PS6, Decelerate to stop=('PS5)&(!PS6), External
fault 5=S4, Fault reset=(1S4)&S3

VFD function code setting: P00.01=2, P00.02=4, P00.06=a value ensuring the set frequency
isnot 0
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The following figure shows the code example and partial testing result (about fault occurring):

1
I
—— - mv 1 CCTREL ]
1
T4 5
A —{ mv 2 CCTRL ]
1
T4 5
——— MV 5 CLCTRL ]
i i
Mmoo
MY I_DiState E4MD ]
1
4 ]
- —m—{ mv T COTRL ]
5000 1
4 I 5 I_OutputFr
— A = 1 0 Homv 0 CLTRL )
o
]
| —o mv 5§ CFErr ]
o
6]
—E—{ mv 0 CPErr ]

Figure 5.2 Programming case for terminal-based running/fault control

5.3 For multi-step setting and running

Requirement: An unsigned 16-bit variable APPLE is defined, which increases by 1 circularly
(rang: 0-65535).

When APPLE < 10000, multi-step speed 0 is used.
When 10000 < APPLE < 20000, multi-step speed 1 is used.
When 20000 < APPLE < 30000, multi-step speed 2 is used.
When 30000 < APPLE < 40000, multi-step speed 3 is used.
When 40000 < APPLE < 50000, multi-step speed 4 is used.
When 50000 < APPLE, multi-step speed 5 is used.

The variable APPLE is saved to P27.12 so that the VFD can monitor the value change. When
the S1 terminal on the VFD has input, the VFD runs. When the PS1 terminal on the PLC card
has input, the PRO1 and PRO2 terminals on the PLC card have output.

Implementing method: The LD is used for programming. Add a line to the global variable table
and set the element (for example, D1000) corresponding to APPLE. Note that an element
among D7400-D7699 cannot be used.
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Global variable table } (= MAI |

Variable Name Wariable addr. Comments
290 APPLE D1odo User Defined variable

Figure 5.3 Defining a global variable APPLE

VFD function code setting: P00.01=2, P00.02=4, P00.06=6, multi-step speed settings in P10
The following figure shows the code example and partial testing result:
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00
DD
v
27721
H 3= APPLE
27721
H 3= APPLE
27721
H 5=  APPLE
27721
4 >=  WPFLE
27721
4 >=  WPFLE
27721
4 >=  WPFLE
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v
m
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]
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|
| sET
SET
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Lt T
EST

2rrz1

16$2710

16#4E20
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1649040
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1
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5
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oFF

w

oFF

b1

OFF

o

oFF

b1

277zl

1 WPLE ]
27721
CMPL ]
3
—t—o MV 1 C_MFrq
3
—At—o MoV 2 C_MFrq
3
—t—T M 3 C_MFrq
3
it MV 2 CMFrq
3
—t—{ Mwv 5 CMFrq
3
—t— Mwv & CMFrq
1
K4 ]
1
COTRL ]
1
CCIEL ]
1
i H mv o C_CTRL

Figure 5.4 Programming case for multi-step setting and running

As shown in the preceding figure, APPLE may be negative. This is because the system
considers the single D element (APPLE) as an integer during the increase and therefore uses
signed display. The D elements on the Auto Station can be divided into the integer type and
the long integer type, but not the unsigned integer type. The preceding judging zone uses the
hex restriction method. No change can be made for the transfer to P27.12 since the data

showed in P27.12 is an unsigned number.
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5.4 For RS485 communication

Requirement: The bus voltage of 2# VFD can be obtained, the input from All on the PLC card
is used to set the frequency for 2# VFD, and PS1 on the PLC card is pressed to run 2# VFD
forward. For 3# VFD on the RS485 cable, the output frequency can be read, and the set
frequency can be changed and can increase automatically by 1Hz.

485-
PLC Card(1#)
485+
$ 485+ 485-
485+  |485-
VFD (2#) VFD (3#)

Figure 5.5 PLC card networking example

Implementing method: The LD is used for programming. On the left of the Auto Station,
expand System block, double-click Serial port, select the parameter settings for PLC
communication port (1), choose the Modbus protocol, and right-click Modbus setting. The
default setting is Slave Station. Change the setting to Master Station, set the site number to
1, and retain other default settings. (Note: For Modbus communication, all other parameters
must use default settings except the site number. This is to keep the same protocol for the two
sides.) Regarding the hardware, short connect AV on the PLC card to J2, and short connect
AVO on the PLC card to J5 (this is the default short-connection). Connect the 485+ terminal
on the PLC card to the 485+ terminals on 2# VFD and 3# VFD, and connect the 485- terminal
on the PLC card to the 485- terminals on 2# VFD and 3# VFD.

VFD function code setting: Set P14.00=2, P00.01=2, and P00.02=4 for 2# VFD. Set P14.00=3
for 3# VFD.

[}
Moo
SET sM172 ]
OFF

BST ST ]

My 6 sDLTE )
o

SET SMTE ]
OFF

BT SMm ]
7528 3785

v C_Ailvel 2 T2001 1
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1
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Figure 5.6 Programming case for RS485 communication
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Appendix 1 D elements for exchange between the PLC card

and VFD

Auto Station
interface variable
name

D element

VFD
function
code

Interface description

|_SetFrq

D7400

P17.00

Set frequency of the VFD. It is
read only.

|_OutputFrq

D7401

P17.01

Output frequency of the VFD. It
is read only.

I_LineSetFrq

D7402

P17.02

Ramp reference frequency of the
VFD. Itis read only.

|_DiState

D7403

P17.12

|_DiState is an unsigned 16-bit
number, which is read only.
Each bit represents a unique
digital input terminal on the VFD:
Bit0: S1

Bitl: S2

Bit2: S3

Bit3: S4

Bit4: S5 (VFD 1/O extension card
input terminal S5)

Bit5: S6 (VFD /O extension card
input terminal S6)

Bit6: S7 (VFD 1/O extension card
input terminal S7)

Bit7: S8 (VFD I/O extension card
input terminal S8)

Bit8: HDIA (for digital input)

Bit9: HDIB (for digital input)
Bit10-Bit15: Reserved

I_DoState

D7404

P17.13

Digital output terminal status of
the VFD. Itis read only.

|_TorgSet

D7405

P17.15

Torque reference value of the
VFD. Itis read only.

I_CounterVval

D7406

P17.18

Count value of the VFD. Itis read
only.

I_AIL

D7407

P17.19

0.00-10.00V/0.00-20.00mA. It is
read only.
VFD analog input terminal All,
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Auto Station VFD
interface variable D element function Interface description
name code
corresponding to 0-1000/0-1000
-10.00-10.00V. It is read only.

I_AI2 D7408 P17.20 VFD analog input terminal Al2,
corresponding to -1000-1000
0.00-10.00V/0.00-20.00mA. It is
read only.

I_AI3 D7409 P19.09 VFD /O extension card analog
input terminal Al3, corresponding
to 0-1000/0-1000
HDIA input frequency of the

|_HDIA_F D741 P17.21 .
- 1 0 VFD. Itis read only.
|_HDIB_Frq D7411 p17.22 HDIB |-nput frequency of the
VFD. Itis read only.
| PID Set D7412 P17.23 PID reference value. It is read
- - only.
| PID Feedback D7413 p17.24 PID feedback value. It is read
- - only.
P PID output. It i d
|_PID_Output D7414 p17.3g | ' 10%€ss output. 1t Is rea
only.
Actual fi f th der.
|_EncoderFrg D7415 p1g.op | fClud frequency otthe encoder
It is read only.
Indicates whether to enable the
|_CardEnable D7416 P27.00 PLC card function, which is

reserved. It is read only.

11_Reservel-7

D7417-D7423

Reserved.

CW, which is the first PZD sent

-WrSend PZ1 prazd ! from the DP/CANopen/PN card
PZD2 t f th
- WrSend_P2D2 prazs ! DP/CANopZir;PN carziom ©
1 Wroend Pzbs praze ! EIZDI/:)CgANopseir;I;N ca::iom e
WrSend_PZ0A ot ! EIZDI/:)SANopSei;‘I;N ca::iom e
1 Wroend _P2bs prazs ! EIZDI/:)CSANopSei;‘I;N ca];rdom e
I_WrSend_PZD6 D7429 / PZD6  sent  from the

DP/CANopen/PN card
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Auto Station VFD
interface variable D element function Interface description
name code
PzZD7 sent from the
I_WrSend_PzD7 D7430 / DP/CANopen/PN card
PZD8 sent from the
I_WrSend_PZD8 D7431 / DP/CANopen/PN card
PZD9 sent from the
I_WrSend_PZD9 D7432 / DP/CANopen/PN card
PZD10 sent from the
I_WrSend_PZD10 D7433 / DP/CANopen/PN card
PzD11 sent from the
I_WrSend_PzZD11 D7434 / DP/CANopen/PN card
PzZD12 sent from the
I_WrSend_PzZD12 D7435 / DP/CANopen/PN card
|_RdSend_PZzD1 D7436 / SW, which is the first PZD sent
from the VFD
|_RdSend_PZD2 D7437 / PZD2 sent from the VFD
|_RdSend_PZD3 D7438 / PZD3 sent from the VFD
|_RdSend_PZD4 D7439 / PZD4 sent from the VFD
|_RdSend_PZD5 D7440 / PZDS5 sent from the VFD
|_RdSend_PZD6 D7441 / PZD6 sent from the VFD
|_RdSend_PZD7 D7442 / PZD7 sent from the VFD
|_RdSend_PZD8 D7443 / PZD8 sent from the VFD
|_RdSend_PZD9 D7444 / PZD9 sent from the VFD
|_RdSend_PZD10 D7445 / PZD10 sent from the VFD
|_RdSend_PzZD11 D7446 / PZD11 sent from the VFD
|_RdSend_PZD12 D7447 / PZD12 sent from the VFD
11_Reserve8-55 D7448-D7495 / Reserved
|_OutputVolt D7500 P17.03 Output voltage. It is read only.
|_OutputCurrent D7501 P17.04 Output current. It is read only.
|_MotorRpm D7502 P17.05 Motor speed. It is read only.
|_TorgCurrent D7503 P17.06 Torgue current. It is read only.
|_MagCurrent D7504 P17.07 Exciting current. It is read only.
|_MotorPower D7505 P17.08 Motor power. It is read only.
|_OutputTorq D7506 P17.36 Output torque. It is read only.
|_EstMotorFrq D7507 P17.10 Estimated motor frequency. It is
read only.
I_DC_Volt D7508 P17.11 DC bus voltage. It is read only.
|_LineSpeed D7509 P17.16 Linear speed. It is read only.
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Auto Station VFD
interface variable D element function Interface description
name code
|_PowerFactor D7510 p17.05 | Motor power factor. It is read
- only.
| CurRuntime D7511 P17.26 Current running time. It is read
- only.
Simple PLC and current step
|_CurStage D7512 P17.27 number of multi-step speed. It is
read only.

Pole angle of open-loop
|_SynMagAngle D7513 P17.29 synchronous motor. It is read

only.

Exciti t ref Lt

| MagCurSet D7514 P17.33 xciting current reference is
read only.

T t ref i
I_TorgCurSet D7515 p17.34 | ordue cument reference. 1t Is

read only.

I_LineAC_Cur D7516 P17.35 AC incoming current. It is read
only.

Mot tput t Lt
|_MotorOutTorq D7517 P17.09 otor output torque Is read
- only.

Rectifi i |
|_T_Sink D7518 P07.11 ecter bf'dge module
- temperature. It is read only.
| T Invert D7519 P0O7.12 !nvertlng module temperature. It
- = is read only.

| InvertRuntime D7520 P07.14 Accumulative running time. It is
- read only.
|_ElectricHigh D7521 P07.15 MSB O.f V.FD electricity
- consumption. It is read only.
|_ElectricLow D7522 P07.16 LSB O.f V.FD electricity
- consumption. It is read only.
Type of present fault. It is read
I_FaultType D7523 po7.27 | YPEOIP

only.

Running frequency at most
|_FaultRunFrq D7524 po7.33 | unmng  lrequency

recent fault. It is read only.

Ramp reference frequency at
I|_FaultLineFrg D7525 P07.34 P requency

most recent fault. It is read only.

|
|_FaultoutVolt D7526 po7.35 | Output voltage at most recent
fault. It is read only.
|_FaultOutCur D7527 P07.36 Output current at most recent
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fault. It is read only.
| FaultDeVolt D7528 PO7.37 Bgs voltage at most recent fault.
- Itis read only.
|_FaultTemper D7529 P0O7.38 Max. temperature at most recent
fault. It is read only.
| FaultDi D7530 P0O7.39 Input termina! status at most
- recent fault. It is read only.
| FaultDo D7531 PO7.40 Output termingl status at most
- recent fault. It is read only.
VFD status 1. It is read only.
1: In forward running
I_InvtStatel D7532 / 2: Inreverse running
- 3: Stopped
4: Faulty
5: PoFF
VFD status 2. It is read only.
Bit0: =0: Not ready to run =1:
Ready to run
Bit1-Bit2: =00: Motor 1=01:
Motor 2 =10: Motor 3 =11:
Motor 4
Bit3: =0: Asynchronous motor
=1: Synchronous motor
Bit4: =0: No overload alarm =1:
Overload alarm
Bit5-Bit6: =00: Keypad-based
I_InvtState2 D7533 / control =01: Terminal-based
control =10:
Communication-based control
Bit7: Reserved
Bit8: =0: Speed mode =1:
Torque mode
Bit9: =0: Non position mode =1:
Position mode
Bit10-Bitll: =00: Without-PG
vector control mode 0 =01:
Without-PG vector control mode
1 =10: Closed-loop vector control
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mode =11: V/F control mode
Bit12—Bit15: Reserved
I_InvtErrCode D7534 / VFD fault code. It is read only.
Value that the VFD writes to
I_WrP1 D7535 / WrP1 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP2 D7536 / WTrP2 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP3 D7537 / WTrP3 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP4 D7538 / WrP4 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP5 D7539 / WTrP5 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP6 D7540 / WrP6 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP7 D7541 / WrP7 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrpP8 D7542 / WrP8 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP9 D7543 / WrP9 on the PLC card. It is read
only.
Value that the VFD writes to
I_WrP10 D7544 / WrP10 on the PLC card. It is
read only.
I|_CtriMode D7545 P17.40 Motor control mode. It is read
only.
|_TorqUpElec D7546 P17.41 Ellectromotion torque upper limit.
Itis read only.
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|_TorqUpGen D7547 p17.42 Braking torque upper limit. It is
read only.
Frequency upper limit of forward
|_TorgFrqUpFwd D7548 P17.43 running in torque control. It is
read only.
Frequency upper limit of reverse
|_TrogFrqUpRev D7549 P17.44 running in torque control. It is
read only.
12_Reservel-10 D7550-D7559 / Reserved
12_Reservell-46 D7560-D7595 / Reserved

C_CTRL

D7600

0-10. It is readable and writable.
The options are as follows:
Disable

Run forward (FWD)

Run reversely (REV)

Jog forward

Jog reversely

Decelerate to stop

Coast to stop

Reset the fault

Quick and emergency stop
Reserved

10: Reserved

N WNEO

C_MFrq

D7601

0-16. It is readable and writable.
The options are as follows:
Disable

Multi-step speed 0
Multi-step speed 1
Multi-step speed 2
Multi-step speed 3
Multi-step speed 4
Multi-step speed 5
Multi-step speed 6
Multi-step speed 7
Multi-step speed 8

10: Multi-step speed 9

11: Multi-step speed 10
12: Multi-step speed 11

©OoNOAaRWNREO
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13: Multi-step speed 12
14: Multi-step speed 13
15: Multi-step speed 14
16: Multi-step speed 15
0-4. It is readable and writable.
The options are as follows:
0: ACC/DEC time 1
c_seT pr602 / 1: ACC/DEC time 2
2: ACC/DEC time 3
3: ACC/DEC time 4
0-63000 (corresponding to
0-630.00Hz). It is readable and
writable.

C_FRQ_SET D7603 / To enable the PLC card to set
the  VFD frequency, set
P00.06/P00.07=14.

-3000-3000 (corresponding to
-300.0%—-300.0%). It is readable
and writable.

C_TOR_SET D7604 / To enable the PLC card to set
the VFD torque, set P03.11=12
and P03.32=1.

0-63000 (corresponding  to
0-630.00Hz). It is readable and
writable.

C_F_UP_FWD D7605 / To enable the PLC card to set
forward torque upper limit, set
P03.32=1, P00.00 to a value
rather than 2, and P03.14=11.
0-63000 (corresponding to
0-630.00Hz). It is readable and
writable.

C_F_UP_REV D7606 / To enable the PLC card to set
reverse frequency upper limit,
set P03.32=1, P00.00 to a value
rather than 2, and P03.15=11.

C.T_UP_ELEC D7607 | 0-3000 (corresponding to

0-300.0%). It is readable and
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writable.

To enable the PLC card to set
electromotion torque upper limit,
set P03.32=1, P00.00 to a value
rather than 2, and P03.18=10.

C_T_UP_GEN

D7608

0-3000 (corresponding to
0-300.0%). It is readable and
writable.

To enable the PLC card to set
braking torque upper limit, set
P03.32=1, P00.00 to a value
rather than 2, and P03.19=10.

C_ACC1

D7609

0-36000 (corresponding  to
0-3600.0s). It is readable and
writable.

When VFD ACC time 1is setto a
value rather than O through the
PLC card, ACC time 1 specified
by the value is forcibly used
(P00.11 is invalid). When VFD
ACC time 1 is set to 0 through
the PLC card, ACC time 1
(P00.11) set through the VFD
keypad is used.

C DEC1

D7610

0-36000 (corresponding to
0-3600.0s). It is readable and
writable.

When VFD DEC time 1is setto a
value rather than O through the
PLC card, DEC time 1 specified
by the value is forcibly used
(P00.12 is invalid). When VFD
DEC time 1 is set to 0 through
the PLC card, DEC time 1
(P00.12) set through the VFD
keypad is used.

C_P_Err

D7611

PLC Card-defined fault. It is
readable and writable.
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No fault (fault cleared)

PLC Card-defined fault 1

PLC Card-defined fault 2

PLC Card-defined fault 3

PLC Card-defined fault 4

PLC Card-defined fault 5

PLC Card-defined fault 6

PLC Card-defined fault 7

PLC Card-defined fault 8

PLC Card-defined fault 9

10: PLC Card-defined fault 10
The C_P_Err fault code ranges
from 1 to 10. A fault code greater
than 10 is invalid.

C_PID_GV_S

D7612

-1000-1000 (corresponding to
-100.0-100.0%). It is readable
and writable.

To enable the PLC card to set
the VFD PID reference value, set
P00.00 to a value rather than 2,
P00.06=7 and P09.00=11.

C_PID_FB_S

D7613

-1000-1000 (corresponding to
-100.0-100.0%). It is readable
and writable.

To enable the PLC card to set
the VFD PID feedback value, set
P00.00 to a value rather than 2,
P00.06=7 and P09.02=9.

C_MoP1

D7614

MoP1 value monitored by the
VFD. It is readable and writable.

C_MoP2

D7615

MoP2 value monitored by the
VFD. It is readable and writable.

C_MoP3

D7616

MoP3 value monitored by the
VFD. It is readable and writable.

C_MoP4

D7617

MoP4 value monitored by the
VFD. It is readable and writable.

C_MoP5

D7618

MoP5 value monitored by the
VFD. It is readable and writable.
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MoP6 value monitored by the

C_MoP6 D7619 ! VFD. It is readable and writable.

MoP7 value monitored by the

C_MoP7 D7620 ! VFD. It is readable and writable.

MoP8 value monitored by the

C_MoP8 b7621 ! VFD. It is readable and writable.

MoP9 value monitored by the

C_MoP9 D7622 ! VFD. It is readable and writable.

MoP10 value monitored by the

C_MoP10 D7623 / VFD. It is readable and writable.

0-1000 (corresponding to
0-100.0%). It is readable and
writable.

C_VF_SET D7624 / To enable the PLC card to set
the VFD VF voltage, set
P04.00=5 (user-defined V/F) and
P04.27=12.

C_UP_FRQ D7625 / Frequency upper limit. Reserved.

C_SetDo is an unsigned 16-bit
number, which is readable and
writable.

Each bit represents a unique
digital output terminal of the
VFD:

Bit0: Y1

Bit1l: HDO (for digital output)
C_SetDo D7626 / Bit2: Y2 (VFD 1/O extension card
output terminal Y2)

Bit3: RO1

Bit4: RO2

Bit5: RO3 (VFD /O extension
card output terminal RO3)

Bit6: RO4 (VFD /O extension
card output terminal RO4)
Bit7-Bit15: Reserved

0.00-10.00V/0.00-20.00mA. It is
C_SetAO1 D7627 / readable and writable.
VFD analog output terminal AO1,
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corresponding to
-1000-1000/0-1000

0.00-10.00V/0.00-20.00mA. It is
readable and writable.

VFD /O extension card analog
output terminal AO2,
corresponding to
-1000-1000/0-1000

C_SetAO2 D7628 /

C_SetAO3 D7629 / Reserved.

It displays the current running
status of the PLC card. It is read
C_RunStopState D7630 pP27.11 only.

0: Stopped

1: Running

0-Ox3F. Itis read only.
PLC card digital input terminal
status. Bit5-Bit0  represent
PS6-PS1 respectively.

C_DiState D7631 P27.22

0-0x3. Itis read only.

PLC card digital output terminal
status. BitO represents PRO1,
and Bitl represents PRO2.

C_DosState D7632 pP27.23

0-10.00V/0.00-20.00mA. It is
read only.

To use the PLC card input
terminal All, you need to
SM172, SM173, and SM174.
After the setting, the input value
(corresponding to
0-10000/0-10000) of the PLC
card input terminal All can be
read from SD172 or
D7633(C_Ailval). The value is
also synchronized to P27.24.

For SM172, the value 1 indicates
enabling input, while the default
value 0 indicates disabling input.
For SM174, the value 1 indicates

C_Ailval D7633 P27.24

-58-




Auto Station programmable extension card Appendix 1

Auto Station VFD
interface variable D element function Interface description
name code
current input, while the default
value 0 indicates voltage input.
SD173 specifies the sampling
count.
0-10.00V/0.00-20.00mA. It is
readable and writable.
To use the PLC card input
terminal AO1, you need to
SM178 and SM179. After the
setting, a value (corresponding
to 0-10000/0-10000) can be
written to SD178 to enable AO1
to output current or voltage. The
value is also synchronized to
P27.25.
For SM178, the value 1 indicates
C_Aolval D7634 p27.25 enabling output, while the default
value 0 indicates disabling
output.
For SM179, the value 1 indicates
current output, while the default
value 0 indicates voltage output.
Note: D7634(C_AolVval) only
has the display function and
cannot be used for programming.
That is, writing a value to
D7634(C_Aolval) does not
change the output value of AO1.
C_Reserve5 D7635 / Reserved
C_WrRece_PZD1 D7636 / CW sent to the VFD
C_WrRece_PZD2 D7637 / PZD2 sent to the VFD
C_WrRece_PZD3 D7638 / PZD3 sent to the VFD
C_WrRece_PZD4 D7639 / PZD4 sent to the VFD
C_WrRece_PZD5 D7640 / PZD5 sent to the VFD
C_WrRece_PZD6 D7641 / PZD6 sent to the VFD
C_WrRece_PzZD7 D7642 / PZD7 sent to the VFD
C_WrRece_PZD8 D7643 / PZD8 sent to the VFD
C_WrRece_PZD9 D7644 / PZD9 sent to the VFD
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C_WrRece_PZD10 D7645 / PZD10 sent to the VFD
C_WrRece_PZD11 D7646 / PZD11 sent to the VFD
C_WrRece_PZD12 D7647 / PZD12 sent to the VFD
¢ RdRece PZD1 D7648 / SW sent to the DP/CANopen/PN
- - card

PZD2 sent to the
C_RdRece_PZD2 D7649 / DP/CANopen/PN card

PZD3 sent to the
C_RdRece_PZD3 D7650 / DP/CANopen/PN card

PZD4 sent to the

RdR PZD4 D7651

C_RdRece_ 65 / DP/CANopen/PN card

PZD5 sent to the
C_RdRece_PZD5 D7652 / DP/CANopen/PN card

PZD6 sent to the
C_RdRece_PZD6 D7653 / DP/CANopen/PN card

PzZD7 sent to the
C_RdRece_PZD7 D7654 / DP/CANopen/PN card

PZD8 sent to the
C_RdRece_PZD8 D7655 / DP/CANopen/PN card

PZD9 sent to the
C_RdRece_PZD9 D7656 / DP/CANopen/PN card

PZD10 sent to the
C_RdRece_PZD10 D7657 / DP/CANopen/PN card

PzD11 sent to the
C_RdRece_PZD11 D7658 / DP/CANopen/PN card
C_RdRece_PZD12 D7659 / pzbiz ~ semt  to  the

DP/CANopen/PN card

C_Reserve6-41

D7660-D7695

Reserved
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Function
code

Function
name

Description

Default

Modify

P27.00

PLC card
enable

0~1

Indicates whether to enable the
PLC card function, which is
reserved.

©

P27.01

I_WrP1

0~65535
Value that the VFD writes to WrP1
on the PLC card.

P27.02

I_WrP2

0~65535
Value that the VFD writes to WrP2
on the PLC card.

P27.03

I_WrP3

0~65535
Value that the VFD writes to WrP3
on the PLC card.

P27.04

I_WrP4

0~65535
Value that the VFD writes to WrP4
on the PLC card.

P27.05

I_WrP5

0~65535
Value that the VFD writes to WrP5
on the PLC card.

P27.06

I_WrP6

0~65535
Value that the VFD writes to WrP6
on the PLC card.

P27.07

I_WrP7

0~65535
Value that the VFD writes to WrP7
on the PLC card.

P27.08

I_WrP8

0~65535
Value that the VFD writes to WrP8
on the PLC card.

P27.09

I_WrP9

0~65535
Value that the VFD writes to WrP9
on the PLC card.

P27.10

I_WrP10

0~65535
Value that the VFD writes to WrP10
on the PLC card.

P27.11

PLC card
current status

0~1
It displays the current status of the
PLC card. Itis read only.
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0: Stopped
1: Running
0~65535
p27.12 C_MoP1 MoP1 value monitored by the VFD. 0 o
0~65535
p27.13 C_MoP2 MoP2 value monitored by the VFD. 0 o
0~65535
p27.14 C_MoP3 MoP3 value monitored by the VFD. 0 o
0~65535
P27.15 C_MoP4 0 (]
Mo MoP4 value monitored by the VFD.
0~65535
P27.1 MoP
6 C_MoP5 MoP5 value monitored by the VFD. 0 o
0~65535
P27.17 MoP
C_MoP6 MoP6 value monitored by the VFD. 0 o
0~65535
P27.18 C_MoP7 MoP7 value monitored by the VFD. 0 o
0~65535
P27.19 C_MoP8 MoP8 value monitored by the VFD. 0 o
0~65535
p27.20 C_MoP9 MoP9 value monitored by the VFD. 0 o
0~65535
P27.21 C_MoP10 0 (]
Mo MoP10 value monitored by the VFD.
PLC card gL(éXSZard digital input terminal
P27.22 digital input gt Inp 0x00 ()
terminal status status. Bit5-Bit0 represent
PS6-PS1 respectively.
PLC card glgxiard digital output terminal
P27.23 digital output . 9 P 0x00 [
terminal status status. BitO represents PRO1, and
Bitl represents PRO2.
0~10.00V/0.00~20.00mA
P27.24 PLC card All The Value of PLC card input 0 o
terminal All.
0~10.00V/0.00~20.00mA
P27.25 PLC card AO1 The Value of PLC card output 0 ]
terminal All.
Length of data | 0x01-0x28
P27.2
6 sent from the Ones place: Volume of data sent 0x03 O
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PLC card and from the PLC card. The number of
PZD variables in the sending table is
communication | 12*Ones place.
object 3: VFD send 24+60 variables, while

PLC card send 36 variables. This
value indicates the default variable
transfer method of GD350.

5: VFD send 48+60 variables, while
PLC card send 60 variables. This
value indicates the PLC card on
GD350 communicates with the
DP/CANopen/PN card by using
(24+24) PZDs.

8: VFD send 96+96 variables, while
PLC card send 96 variables. If this
value is used, all variables
(including reserved variables) are
transferred mutually.

You can set the volume of data
sent from the PLC card to another
value, but you need to know the
corresponding variables. Setting
the ones place to another value
only changes the PLC sending
table data quantity (12*Ones
place), which means the VFD send
24 + 60 variables by default.

Tens place: Communication card
with which the PLC card
exchanges PZDs. (It is valid only
when the ones place is 5.)

0: DP card

1: CANopen card

2: PN card

Note: P27.26 can be changed at
any time, but the change takes
effect only after re-power on.
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